Cascade Content Management System Training
The University of Nebraska at Omaha is an equal opportunity educator and employer with a comprehensive plan for diversity.
CASCADE CONTENT MANAGEMENT SYSTEM TRAINING

SECTION 1 - OVERVIEW

HOW TO LOGIN
1. Visit cms.unomaha.edu
2. Using your NetID and password, login in here.

THE DASHBOARD

Here is an example of the dashboard:

In the main area you will see pages you are working on that are in “Draft” form. While pages are in draft form you are the only one that can see them or access them.

You can also find indicators showing pages that are in need of updating. Pages that “need review” have already been submitted to the workflow. The “Last Updated” column indicates pages that have not been updated or modified in a certain period of time. Cascade requires that you “update” pages periodically – this just means that you need to open and review the page in Cascade; you are not required to change any of the content.

The University of Nebraska at Omaha is an equal opportunity educator and employer with a comprehensive plan for diversity.
You can also find messages regarding your workflows on the dashboard if you are a reviewer or approver.

On the left-hand side you will see a listing of folders and files. These correspond to the organization of your site and its navigation.

In the left hand navigation, you will see other icons. The folders are a “holding” area for pages and can correspond to your site’s URL. They each contain an index page

For example, for the College of Education, the index page inside the “About” folder would equal “www.unomaha.edu/college-of-education/about”.

The “community-engagement” folder’s index page would equal “www.unomaha.edu/college-of-education/community-engagement”.

Inside each folder are files that represent the pages on your website.
In the snapshot to the right, the “deans-message” page would equal “www.unomaha.edu/college-of-education/about/deans-message”

Index = the landing page for an area (such as About Us or Academics)
HYPERLINKS

Hyperlinks are simply text that also serves as a link to a different web page. In Cascade there are two kinds of hyperlinks:

- Internal Links - documents, images, pages created WITHIN your site in Cascade
- External Links – documents, websites that are not within your site in Cascade
  - External websites that are not managed by UNO (www.google.com, for example)
  - UNO websites that are not within your Cascade site (ex: unomaha.edu/university-communications)
  - Email addresses

USING THE WYSIWYG (What You See Is What You Get)

Editing in the open field areas is comparable to using a standard Word processor. Most of the icons will be recognizable. Here are some additional symbols.

| Insert Symbol or Custom Character – new symbol, click before the text where the symbol should be |
| Paste as Plain Text – use when copying from emails and documents |
| Find/Replace |
| Insert/Edit Link
  - New Link – highlight text or select image
  - Current Link – select current link just by clicking inside it – do not highlight |
| Remove Link
  - Current link – select current link just by clicking inside it – do not highlight |
| Insert/Edit Anchor - Placeholder within a page to link to
  - New Anchor – click before the text where the anchor should be Current Anchor – select the just by clicking on it |

The University of Nebraska at Omaha is an equal opportunity educator and employer with a comprehensive plan for diversity.
“SYSTEM NAME” NAMING CONVENTIONS
Pages, Folders & Files – No spaces or special characters (!@#$%^&*); all lowercase and use hyphens
Files – all lowercase, use hyphens instead of spaces, must include file extension (ex: doc, pdf)

DISPLAY NAME VS. SYSTEM NAME VS. TITLE
Display Name – Name seen in the navigation of a web page (Registrar Home) System Name – Name seen in
the web address/URL (http://www.unomaha.edu/registrar/index.php)
Title – Name seen in the Title Bar of the Internet Browser (Registrar-University of Nebraska Omaha)

WORKFLOW IN CASCADE
Workflow is the process in place that provides checks & balances, and how the page gets published. A
workflow is created after a contributor makes edits to a draft, and hits the submit button. Once a draft is
submitted, a workflow is sent to an approver. An approver is someone in place to review any final drafts before
they are made live, to double check the information and ensure accuracy.

Your dashboard is where you can find any workflows you have created.
The University of Nebraska at Omaha is an equal opportunity educator and employer with a comprehensive plan for diversity.
SECTION 2 – GENERAL CASCADE SKILLS

HOW TO LOG INTO THE CASCADE

You can use any browser to log in to Cascade.

1. Just type in: https://cms.unomaha.edu/

2. Then log in using your NetID and password (it’s the same as your log in information for your UNO email account)

Once you are logged in, you will see the Cascade Server CMS dashboard. It will display information and sites relevant to you and the access you have been given by your CASCADE Administrator.

CASCADE will automatically log you out of the system if there is no activity for an extended period of time.

You can log in to CASCADE anywhere on the UNO campus. If you are off campus and wish to access CASCADE you will need to install VPN on your computer. The University has a Virtual Private Network (VPN) available for anyone with a valid NetID. Connecting to the VPN allows you to access your files, connect to network shares, and more. Connect to the UNO VPN with your NetID credentials here: https://uno-vpn.unomaha.edu.

Contact the Help Desk at 402.554.4357 or unohelpdesk@unomaha.edu to inquire about installing the VPN on your computer.
HOW TO EDIT A PAGE

Select a page from the left-side panel, and then use the arrow to the right of the page to select EDIT. Or, simply double click on the page icon in the left-side panel to open for editing.

There are two ways to change content on a page. You can edit using the Edit tab.

Or you can click on the “View” tab and edit using the LAYOUT MODE. You can also access this mode by clicking on any of the “pencils” in the layout.

The University of Nebraska at Omaha is an equal opportunity educator and employer with a comprehensive plan for diversity.
HOW TO UPLOAD A PHOTO

Find the img or images folder, and click on it so it is selected. Then, go to the blue bar at the top of the dashboard.

Select NEW> DEFAULT> FILE

Before uploading a photo to Cascade, rename the image using only lowercase letters and hyphens for spaces. If you happen to upload an image that has the same name as an image that has already been uploaded, Cascade will automatically add a “1” so images won’t be overwritten.

HOW TO ADD BULLETS

1. Highlight text you need bulleted
2. Select the button that stands for bulleted in the formatting tools. You won’t see the bullets appear yet.
3. While that text is still highlighted, go up to the Styles drop down, click on it and select Standard. You should see the bullets after this step.
4. Next go back to that drop down and select indent. This should indent your bullets.
RECOMMENDED PHOTO DIMENSIONS

Adobe Cloud is free now so you/others can get Photoshop if needed. If you're using a Mac, you can open the file, then File > Save a Version > JPEG from the dropdown. If you have Photoshop you can do that there, in addition to compressing images using File > Save for Web & Devices.

Desired file size is 200 kb or less for photos

For “College Sites” (pages that are built within colleges)

COLLEGE HOME PAGE
Feature (these images are uploaded via the News Center): 630px wide x 420px tall
Feature Mobile (these images are uploaded via the News Center): 300px wide x 300px tall
Sidebar Feature: 300px wide x 110-200px tall

DEPARTMENT LANDING PAGE
Content Feature: 630px wide x 420px tall
Sidebar Feature: 300px wide x 110-200px tall

COLLEGE STANDARD PAGE
Content Area Images: 450px wide x 300px tall
Sidebar Feature: 300px wide x 110-200px tall

BLOG IMAGES
Feature: 450px wide x 300px tall
Mobile: 300px wide x 300px tall

For “UNO Sites” (administrative offices such as Financial Support & Scholarships, Graduate Studies, etc.)

PORTAL PAGE
Banner Image: 1920 x 380
Grey Button Images: 300 x 200
Pre Footer image: 460 x 300

OFFICE PAGE
Banner Image: 1920 x 380
Sidebar Feature Image: 300 x 200
Body Image: 300 x 295
Pre Footer image: 460 x 300

CENTER PAGE
Sidebar Feature Image: 300 x 200
Content Feature (carousel images): 620 x 420

STANDARD PAGE
Sidebar Feature Image: 300 x 200
Body Image: 450 x 300
HOW TO CREATE A NEW PAGE

Click on the folder you want the page to exist in.

Go to the blue bar on the top of the page and click NEW. The dropdown menu will reveal your template options. Select your template.

Under the CREATE tab, stay in CONTENT on the blue bar, and make sure SYSTEM NAME is entered, the correct PARENT FOLDER (location of your page), and all required fields, and then scroll down and press SUBMIT (grey bar at the bottom of the page).

Note: When entering SYSTEM NAME use lowercase letters and hyphens. If necessary, you can change the name later by using the MOVE/RENAME tab.
HOW TO ADD AN INTERNAL PAGE TO NAVIGATION

CASCADE helps you dynamically create links in the navigation. Each page has an option to be included in the navigation – you just need to select yes or no to have it display.

Display Name = what will appear in the navigation
Title = what will appear on the title bar of the browser
“Include in navigation?” – select yes or no

HOW TO ADD AN EXTERNAL PAGE TO NAVIGATION

If you want to create a navigation item that links to a page outside of your site you will need to create an “external link.”

1. Select the folder for the new link:
2. New > Default > External Link
3. In Content/Create
   a. Enter Display Name
   b. Type the Title
   c. Type or paste the URL for the link in the Link field
4. Save draft or submit for workflow
HOW TO CREATE A HYPERLINK

In the CONTENT tab, under EDIT mode on a page, highlight the text that you would like to be the link. Click the INSERT/EDIT LINK icon.

For documents within your website, use the INTERNAL option and click the brackets to browse to the document.

For external websites outside of your own site, click the EXTERNAL option and paste the full link in the link box. Note: An external website could still be a UNO website.

For emails, replace the "http://" with “mailto:" and enter the email address. For example, mailto:jsmith@unomaha.edu
HOW TO BULLET

1. Highlight text you need bulleted
2. Select the button that stands for bulleting in the formatting tools.
   *you won’t see the bullets appear here
3. While that text is still highlighted, go up to the Styles drop down, click on it and select Standard.
   *You should see the bullets after this step.
4. Next go back to that drop down and select indent.
   *this should indent your bullets.
HOW TO INSERT AN IMAGE

In CONTENT/EDIT mode on a page, click the INSERT/EDIT IMAGE icon. Find the “Content >> Feature” box. Click on the arrow to open box.

Browse to the image by clicking the brackets.

This window will allow you to choose an image that is already in Cascade, or you can use this window to upload.

Before you INSERT, enter ALTERNATE TEXT briefly describing the image.
HOW TO CREATE A TABLE

Creating a table in CASCADE can be done two different ways, but we recommend creating a new table.

OPTION 1: To create a new table, go to the page on which you want to place the table. Go into “edit” and then into the content block.

1. Select the “insert table” icon, as shown below:

![Insert Table Icon](image)

2. In the Insert/Edit Table window that pops up, determine the number of columns and rows you wish to include in your table. In the “Class” drop down field, select “gridded” which will format the standard grid style of table.

![Insert/Edit Table Window](image)

Select “Insert” and expand the table to the desired size.
3. To add the table headers, you will need to right-click on the top table row and choose row>table row properties. Once in window choose row type and select header and update.

4. Then right click the table header row again and choose cell>table cell properties. Once in window select cell type and select header AND choose “update all cells in row”, then update again.

5. Your table is now ready for content

The University of Nebraska at Omaha is an equal opportunity educator and employer with a comprehensive plan for diversity.
OPTION 2: If you already have a table on a previous site or document, it can be moved over by copying and pasting it into a content block. You will then need to update the formatting:

1. Select the table that you wish to move into your CASCADE template.
2. Highlight the table, and select the “copy” option.
3. Switch back to your CASCADE screen, and select the content block you would like to insert your table into.
4. While in the new content block, select the “paste” option.

Highlight the new table in your content block, and select the “gridder” option from the “styles” drop down menu.

Follow steps 2 through 4 from Option 1 to finish formatting your table.
HOW TO REARRANGE YOUR NAVIGATION

1 – Double click on the folder you want to arrange. A window should open up on the right that displays all the files, pages, etc. within the folder.
2 – Sort by clicking on the "Order" column.
3 - Use the blue arrows (under the "Actions" column) to arrange the order.

HOW TO CREATE ANCHORS FOR “JUMP-TO” NAVIGATION

Jump to navigation is essentially allowing users to jump to various parts of a page without having to scroll through ALL of the information. For example, if you have a long page, and you want to let readers jump straight to Part 1, Part 2, or Part 3 of the page from a table of contents at the top.

For example, you have a FAQ page. You could list all of your questions in a list at the top of the page and all of your answers below. The questions will become hyperlinks and the answers will be the “anchors” users will jump to.

   Step 1. Select and highlight the headline of the copy that will be the anchor.
   Step 2. Highlight the anchor headline copy and select the anchor icon from the toolbar.

   ![Insert/Edit Anchor](image)

   Step 3. You will see the Insert/Edit Anchor window and you will type in a short name for the anchor. You need to remember this name for later in the process.

   ![Insert/Edit Anchor Window](image)

   Step 4. Select the copy that will be the hyperlink and highlight it. Then select the hyperlink icon from the toolbar. In the Insert/Edit Link window, type in the name for the anchor in the “anchor” field.

   ![Insert/Edit Link Window](image)
Step 5. Test the link. On the preview tab within CASCADE, right click on your hyperlink and click open in new tab. Within this new tab you will be able to test the links.
SECTION 3 - FAQ & TROUBLESHOOTING

Where do I login?
https://cms.unomaha.edu/

What is my login info?
Your login info is your NETID. The username is typically first initial of first name, last name (ex. jsmith) and then your corresponding password.

Which template do I use?
Most often, you will use the Standard page.

Paragraphs are not aligning correctly. What can I do?
In CONTENT/EDIT mode, click inside each paragraph and make sure the FORMAT box says “Paragraph”.

I uploaded a photo and placed it where I needed it but it is not displaying.
Check your file name. There can be no spaces. Use hyphens instead.

I have made edits, but when I go back to the preview icon, I cannot see the changes. What can I do?
Below the preview tab on the top left of the screen, is: (current | draft). Make sure you have selected the DRAFT BUTTON

There is no UPDATE DRAFT button at the bottom of my page, just save draft? (And a pop up states that you currently have a draft for this asset and submitting it will overwrite your existing draft)
Once you open a page, and hit the edit tab, you have created a draft that can only be accessed from your dashboard. It is a common mistake to create a draft, and then later click on the page in the left navigation folders to reopen it. This creates a second draft and CASCADE will only let you make changes to one at a time.

The page I am working on is not in the left file structure. Where is it?
A draft does not appear in the file structure on the left, until it is submitted. You can only access it from your dashboard until submission.

I uploaded a file (.pdf, .jpg, etc.) and it is not in the correct folder.
You can grab the file, drag it and drop it where it needs to go.
GLOSSARY OF TERMS

APPROVER = This person approves and publishes edits made to a page. Same as a “reviewer.”

BROWSER = You will log into Cascade via a browser. Some common browsers are Google Chrome, Firefox, Internet Explorer.

CMS = Content Management System, Cascade is one type of CMS that is used to update or add content to a website.

CONTENT = The words, pictures, links you put on your web pages.

CONTRIBUTOR = This person makes edits to a page then submits them to the workflow.

INDEX = The landing page for an area (such as About Us or Academics)

NAVIGATION = The term used for how a user moves through the site to find the information they need.

REVIEWER = This person approves and publishes edits made to a page. Same as a “approver.”

SITES = Each academic or administrative unit will be given a site or sites for their web pages. For example, a college may have a “site” for each department plus the dean’s office. An administrative office may have just one site for all of its content.

TEMPLATE = UNO has developed a series of templates which are pre-designed pages to be used for different types of content.

WORKFLOW = Workflow is the process in place that provides checks & balances, and how the page gets published. A workflow is created after a contributor makes edits to a draft, and hits the submit button. Once a draft is submitted, a workflow is sent to an approver. An approver is someone in place to review any final drafts before they are made live, to double check the information and ensure accuracy.
CONTACT INFORMATION
If you are experiencing issues, because of the collaborative nature of Cascade, you can use other user on campus as a resource for troubleshooting. For more technical or unit-specific issues, please see the web manager on your unit’s core team of CASCADE users.

University Communications:
For questions about the web project and upcoming phases, contact the Associate Director, Digital Communications – Liz Renner, earenner@unomaha.edu
For questions about web content or social media content, contact the university Content Manager – Sarah Casey, scasey@unomaha.edu
For questions about training, contact CMS Coordinator - Sophie Ibrahimi, sibrahimi@unomaha.edu

Information Services:
For questions about website or CASCADE technical matters, contact the web project’s Technical Lead – Eric Wingert, elwingert@unomaha.edu

General Inquiries can be submitted via the “Start Your Project” form at http://www.unomaha.edu/university-communications/request/start.php